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Preliminary remark 
The Functional Examples dealing with “Safety Integrated” are fully functional 
and tested automation configurations based on A&D standard products for 
simple, fast and inexpensive implementation of automation tasks in safety 
engineering. Each of these Functional Examples covers a frequently occur-
ring subtask of a typical customer problem in safety engineering. 
Aside from a list of all required software and hardware components and a 
description of the way they are connected to each other, the Functional Ex-
amples include the tested and commented code. This ensures that the func-
tionalities described here can be reset in a short period of time and thus also 
be used as a basis for individual expansions. 

Important note 
The Safety Functional Examples are not binding and do not claim to be com-
plete regarding the circuits shown, equipping and any eventuality. The Safety 
Functional Examples do not represent customer-specific solutions. They are 
only intended to provide support for typical applications. You are responsi-
ble for ensuring that the described products are used correctly.  
These Safety Functional Examples do not relieve you of the responsibility of 
safely and professionally using, installing, operating and servicing equip-
ment. When using these Safety Functional Examples, you recognize that 
Siemens cannot be made liable for any damage/claims beyond the liability 
clause described.  We reserve the right to make changes to these Safety 
Functional Examples at any time without prior notice. If there are any devia-
tions between the recommendations provided in these Safety Function Ex-
amples and other Siemens publications – e.g. Catalogs – the contents of the 
other documents have priority. 
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1 Warranty, Liability and Support 
We accept no liability for information contained in this document. 
Any claims against us – based on whatever legal reason – resulting from the 
use of the examples, information, programs, engineering and performance 
data etc., described in this Safety Functional Example shall be excluded. 
Such an exclusion shall not apply in the case of mandatory liability, e.g. un-
der the German Product Liability Act (“Produkthaftungsgesetz”), in case of 
intent, gross negligence, or injury of life, body or health, guarantee for the 
quality of a product, fraudulent concealment of a deficiency or breach of a 
condition which goes to the root of the contract (“wesentliche Vertragspflich-
ten”). However, claims arising from a breach of a condition which goes to the 
root of the contract shall be limited to the foreseeable damage which is in-
trinsic to the contract, unless caused by intent or gross negligence or based 
on mandatory liability for injury of life, body or health. The above provisions 
do not imply a change in the burden of proof to your detriment. 
 
Copyright© 2010 Siemens A&D. It is not permissible to transfer or copy these 
Application Examples or excerpts of them without first having prior authori-
zation from Siemens A&D in writing. 
 
For questions about this document please use the following 
e-mail-address: 
Online-support.automation@siemens.com  
  
 

mailto:Online-support.automation@siemens.com�
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2 Automation function 
2.1 Description of the functionality 

The SINAMICS G120 drive inverter is a modular inverter system with degree of 
protection IP20. It comprises the two function units Control Unit (CU) and Power 
Module (PM). 
When using the Control Unit CU240S PN-F, you have access to the following 
safety functions that are integrated in the drive inverter: 
 

Designation Function Description 

The drive is safely brought into a no-torque condition 

Prevents the drive from accidentally starting STO 
Safe Torque Off 

 (acc. to EN60204) 
Preventing a restart does not require electrical isolation be-
tween the motor and drive inverter 

The drive is quickly stopped and safely monitored 

Independent and continuous monitoring guarantees the short-
est response times when a fault occurs SS1 

Safe Stop 1 
 (acc. to EN60204) 

A speed encoder is not required 

The drive speed is limited and monitored 

Independent and continuous monitoring guarantees the short-
est response times when a fault occurs SLS 

Safely Limited Speed
 (acc. to EN60204) 

A speed encoder is not required 

An 24V external brake is safely controlled 
SBC Safe Brake Control 

In this case, it is necessary to use the Safe Brake Relay 

 
All safety functions are certified according to EN 954-1 (Cat. 3), IEC 61508 (SIL 2) 
and ISO 13849-1 (PL d). 
 
The safety functions are either controlled through two fail-safe digital inputs (4 digi-
tal inputs, which are evaluated through 2 channels in a fail-safe fashion in the CU 
240S PN F) or via PROFIsafe in conjunction with a fail-safe CPU. 
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2.2 Expanded functionality from firmware V3.2 onwards  

With firmware V3.2, the safety functions of SINAMICS G120 have been expanded 
as follows: 
• The SLS safety function has been expanded by mode 3 (refer to Chapter 

4.6.2.5):  
• Using this mode it is possible to start the motor with SLS activated.  

This means that the motor speed/velocity can be safely monitored / 
limited from the start. 

• Further, when SLS is activated it is possible to operate with a fre-
quency below 1Hz for a maximum of 5s. 

• Reversing operation is possible when SLS is activated. 
• The safety-relevant feedback signals of the safety functions in the PROFIsafe 

telegram have been revised. Now, activation is no longer signalled to the F-
CPU - but instead the actual status of the safety function (refer to Chapter 
6.3.2). 

• The acknowledgement of F395 has been significantly simplified (an accep-
tance test is required) (refer to Chapter 4.3.1).  
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2.3 Functionality of the function example 

2.3.1 Task description 

A SINAMICS G120 with its integrated safety functions is to be controlled using an 
F-CPU via PROFINET.  
 

2.3.2 Solution 

In this particular function example, a specific program example will be used to 
demonstrate the control of a SINAMICS G120 (control word and frequency set-
point) and the control of the safety-relevant functions (STO, SLS and SS1) with an 
F-CPU.  
This program example comprises an S7 program to control the SINAMICS G120, 
an S7 safety program and a configured SINAMICS G120. 
 

2.4 Advantages / customer benefits 

Combining safety-relevant and standard programs in one common CPU and estab-
lishing communications between the CPU and drive inverter via a common bus 
(PROFINET) simplify the system design. 
The safety functions are integrated in the drive inverter and are implemented with-
out any speed feedback signal. This means that to some extent complex external 
shutdown and monitoring devices can be eliminated.  
A SINAMICS G120 with Safety Control Unit can replace an existing drive inverter. 
This means that safety functions can be added to 
an existing system with low associated costs and expenditure. 
 

2.5 Structure of the function example 

The download and test of the program examples supplied are described in Chap-
ters 3 to 5.  
More in-depth information is provided in Chapter 6 – together with a description of 
the steps necessary to commission the SINAMICS G120 - so that you can engi-
neer and implement your own projects. 
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2.6 Restrictions 

 !  
Caution 

 
Please take careful note that the two safety functions SLS and SS1 may 
not be used for loads that can drive the motor or loads that are continu-
ally in the regenerative mode.  
 
Elevating platforms, winders, wind turbines are examples of such loads 
that can drive motor or continually regenerate in to the line supply. 
 
An important prerequisite when using fail-safe functions is that the 
closed-loop control functions absolutely perfectly. The drive (system 
comprising the drive inverter + motor + driven load) must be engineered 
so that all operating situations of the particular application are always 
completely under control. 
 

 
 !  

Caution 

 
After the STO and SS1 safety functions have been activated there is no 
electrical isolation between the line power supply of the SINAMICS G120 
and the motor. If this electrical isolation is required in your particular ap-
plication, then you must install an appropriate line contactor upstream of 
the SINAMICS G120. 
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3 Components that are required 
An overview of the hardware and software components required for the function 
example is provided in the Chapter. 

3.1 Hardware components 

Component Type Order No./ordering data Qty Manufacturer 

S7 control 

Power supply PS307 5A 6ES7307-1EA00-0AA0 1 

S7-F CPU  CPU 315F-2 PN/DP 6ES7315-2FH13-0AB0 1 

Memory Card MMC 512 KB 6ES7953-8LJ11-0AA0 1 

DI / DO simulation module SM374 6ES7374-2XH01-0AA0 1 

Safety digital input SM326 6ES7326-1BK01-0AB0 1 

Front connector 40 pin 6ES7392-1AM00-0AA0 1 

Profile rail Profile rail 6ES7390-1AE80-0AA0 1 

PROFINET RJ45 connector * PROFINET connector 6GK1901-1BB10-2AA0 4 

PROFINET cable PROFINET cable 6XV1840-2AH10 5m 

SIEMENS 

Drive 

SINAMICS G120 Control Unit  CU240S PN F (FW3.2) 6SL3244-0BA21-1FA0 1 

SINAMICS G120 Power Module  PM240 6SL3224-0BE21-5UA0 1 

Basic Operator Panel  BOP 6SL3255-0AA00-4BA1 1 

Motor  Three-phase induction 
motor 0,12kW 1LA7060-4AB10 1 

SIEMENS 

Command devices 

Empty enclosure 
Empty enclosure with 4 
command sources (e.g. 
pushbuttons) 

3SB3804-0AA3 1 

Emergency Stop mushroom 
pushbutton (to activate STO and 
SS1) 

Emergency Stop mush-
room pushbutton 3SB3000-1HA20 2 

Mushroom pushbutton (to activate 
SLS) Mushroom pushbutton, red 3SB3000-1DA21 1 

Pushbutton (acknowledge safety 
functions) Pushbutton, red 3SB3000-0AA21 1 

Contact 1NC, screw terminal 3SB3420-0C 6 

Contact 1NO, screw terminal 3SB3420-0B 2 

SIEMENS 

 

Note The functionality was tested with the specified hardware components. 
Similar components that are different from those listed above can be used. 
Please note that in such a case it may be necessary to change the code 
example (e.g. setting other addresses). 

3.2 Software components  

Component Version Order No. / ordering data Qty Manufacturer 

SIMATIC STEP 7 V5.4 + SP5 + 
HF1 6ES7810-4CC08-0YA5 1 

SIMATIC Distributed Safety V5.4 + SP5 6ES7833-1FC02-0YA5 1 

STARTER V4.1 + SP5 + 
HF1 

http://support.automation.siemens.com/
WW/view/en/26233208 1 

GSDML-File CU240S PN-F V3.2 http://support.automation.siemens.com/
WW/view/en/26641490 1 

SIEMENS 

http://support.automation.siemens.com/WW/view/en/26233208�
http://support.automation.siemens.com/WW/view/en/26233208�
http://support.automation.siemens.com/WW/view/en/26641490�
http://support.automation.siemens.com/WW/view/en/26641490�


 

SINAMICS G120; Safety via Profinet with PROFIsafe Entry-ID:29585944
 

 
A&D Safety Integrated Page 11/67 SD-FE-I-005-V20-EN
                                                                                          

  

C
op

yr
ig

ht
 ©

 S
ie

m
en

s 
A

G
 2

01
0 

A
ll 

rig
ht

s 
re

se
rv

ed
 

S
D

_F
E

_I
_0

05
_V

20
_E

N
.d

oc
 

4 Configuration and wiring 
The hardware configuration and connecting-up the function example are described 
in this Chapter. 
Please carefully observe the following safety information & instructions when using 
the SINAMICS G120: 

 !  
Warning 

The SINAMICS G120 has hazardous voltages and controls rotating mechanical 
parts that can also be potentially hazardous. If the warning information is not 
observed or the information & instructions from the instructions belonging to 
SINAMICS G120 are not complied with this could result in death, severe bodily 
injury or significant material damage. 

 

4.1 Overview of the hardware configuration 
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4.2 Connecting-up the hardware components 

4.2.1 S7-300 control and CU240S PN-F 
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4.2.2 PM240 and motor 

 
For more detailed information regarding the installation please refer to the SINAMICS G120 Hardware Installation Manual Power Mod-

ule PM240. Download from: http://support.automation.siemens.com/WW/view/en/22339653/133300

http://support.automation.siemens.com/WW/view/en/22339653/133300�
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4.3 Fault 395 (acceptance test / acknowledgement present) 

Fault F395 is output when powering-up for the first time and after replacing the 
Control Unit (CU) or the Power Module (PM). 
This fault does not represent an incorrect drive inverter function. The reason for 
this fault message is to monitor the individual drive inverter components (CU and 
PM) to prevent them from being replaced by unauthorized personnel. 
 
Acknowledging fault F395 beginning with firmware V3.2 
The acknowledgment of F395 has been significantly simplified with the introduction 
of firmware V3.2. Just like any other fault, it can be acknowledged using an 
appropriately parameterized input, via the field bus or using the STARTER 
parameterizing software.  
 
Acknowledging fault F395 with older firmware versions (<V3.2) 
To acknowledge the F395 in conjunction with older firmware versions, proceed as 
follows: 
• Set parameter p0010 to 30  
• Enter the safety password (standard = 12345) into parameter p9761  
• Set parameter p7844 to 0  
•  F395 will no longer be displayed 
 
Next steps 
The user must then carry-out an acceptance test/check. More information is pro-
vided in the G120 Operating Instructions in Chapter Appendix under Accep-
tance Log.  
Download from: 
http://support.automation.siemens.com/WW/view/en/22339653/133300 
 
Download Acceptance test report from: 
http://support.automation.siemens.com/WW/view/en/35014199 

 
 

 

 

http://support.automation.siemens.com/WW/view/en/22339653/133300�
http://support.automation.siemens.com/WW/view/en/35014199�
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4.4 Important hardware component settings 

Most of the module/board settings are made in the HW Config in the software. 
Hardware settings are only required for the following modules/boards.  
The modules/boards must be set with the control system in a no-voltage state. 

4.4.1 SM374 simulation module  

This module can be operated as 16 x DO (output via LED), 16 x DI (input via 
switch) or as combined 8 x DI / 8 x DO. The last combination is used in this func-
tion description.  
The function of the module is selected using a rotary switch behind the front cover 
between the series of switches.  
As shown in the following diagram set the function switches to the setting 8 x Out-
put 8 x Input. 

 

4.4.2 Safety digital input module SM326 

Before installation, the PROFIsafe address must be set at the rear of the module 
according to HW Config. 
Set the DIL switches as shown in the following diagram. 
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4.5 Overview of inputs and outputs 

4.5.1 Simulation module SM374 

 
 

Address Function Symbolic address Default Explanation  

O 0.7 
Indicator lamp 

Safety functions 
active or error 

Safe_stop_or_error
 0 Activated safety functions (flashing light) and faults 

(steady light) are signaled via this output 

I 0.0 SINAMICS 
G120 start Start_G120 0 The motor connected to SINAMICS G120 is started 

by activating the input 

I 0.1 SINAMICS 
G120 reverse Reverse_G120 0 After the input is activated, a negative frequency 

setpoint is entered (direction of rotation reversal) 

I 0.5 Increase fre-
quency Increase_frequency 0 The motor frequency can be increased using this 

input  

I 0.6 Decrease fre-
quency Decrease_frequency 0 The motor frequency can be reduced using this input 

I 0.7 Acknowledge 
error ACK_error 0 Fault messages that are present can be acknowl-

edged using this input. 
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4.5.2 Safety digital input module SM326 

Overview of the pushbuttons that are connected: 

Address Function Symbolic address Default Explanation 

I 24.0 
STO 

pushbutton 
Safety_PB_STO 

 1 The safety function STO (Safe Torque Off) is initiated using 
this pushbutton 

I 24.1 
SS1 

pushbutton 
Safety_PB_SS1 1 The safety function SS1 (Safe Stop 1) is initiated using this 

pushbutton 

I 24.2 
SLS 

pushbutton 
Safety_PB_SLS 1 The safety function SLS (Safely Limited Speed) is initiated 

using this pushbutton 

I 24.3 

Pushbutton 
for safety 

functions and 
acknowledg-

ing faults 

Safety_PB_ACK 0 
The activated safety functions can be acknowledged using 

this pushbutton - and parallel to I0.7 – also any fault 
messages that might be present, 

 

4.5.3 SINAMICS G120 

The SINAMICS G120 is controlled and the feedback signals read-in via the I/O ad-
dresses listed below. 

 

Address Function 

S7 program -> SINAMICS G120 

PQW256 Control word 1 

PQW258 Frequency setpoint 

PQW260 Torque setpoint 

PQW262 Control word 2 

PAW264 -- Reserve -- 

PAW266 -- Reserve -- 

SINAMICS G120 -> S7 program 

PIW256 Status word 1 

PIW258 Frequency actual value 

PIW260 Current actual value 

PIW262 Status word 2 

PIW264 Last fault number 

PIW266 Last alarm number 

 

For more detailed information about the configuration of the individual signals, 
please refer to SINAMICS G120 Operating Instructions Control Unit CU240S, 
Chapter Commissioning.  

Download from: 
http://support.automation.siemens.com/WW/view/en/22339653/133300 

http://support.automation.siemens.com/WW/view/en/22339653/133300�
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The safety functions of the SINAMICS G120 are controlled from the S7 safety pro-
gram and the status of the safety functions of the SINAMICS G120 is signaled back 
to the S7 safety program using the following signals: 

 

Address PROFIsafe 
telegram bit Symbolic address Function 

S7 safety program -> SINAMICS G120 

Q 14.0 Bit 0 Safety_S7 -> G120_STO 
By switching out this signal, the STO function 
(Safe Torque Off) is activated in the SINAMICS 
G120 

Q 14.1 Bit 1 Safety_S7 -> G120_SS1 
By switching out this signal, the SS1 function 
(Safe Stop 1) is activated in the SINAMICS 
G120 

Q 14.4 Bit 4 * 
Safety_S7 -> G120_SLS_V2 

 

Q 15.0 Bit 8 * Safety_S7 -> G120_SLS_V1 

By switching out this signal, the SLS function 
(Safely Limited Speed) is activated in the 
SINAMICS G120 
The active bit (bit 4 or bit 8) is selected using 
parameterization (refer to Chapter 4.6.2.2) 

SINAMICS G120 -> S7 safety program 

I 14.0 Bit 0 Safety_G120 -> S7_STO_PR 
Feedback signal from SINAMICS G120 to the S7 
safety program, STO (Safe Torque Off) and 
power removed was activated 

I 14.1 Bit 1 Safety_G120 -> S7_SS1 
Feedback signal from the SINAMICS G120 to 
the S7 safety program that the SS1 ( Safe Stop 
1) deceleration ramp is active.  

I 14.4 Bit 4 ** 
 

Safety_G120 -> S7_SLS_V2 
 

I 15.0 Bit 8 ** Safety_G120 -> S7_SLS_V1 

Feedback signal from the SINAMICS G120 to 
the S7 safety program that the actual motor 
frequency lies below the SLS (Safely Limited 
Speed) limit frequency.  
Both bits have the same priority and are used to 
feed back the SLS status to the S7 safety 
program. 

 

* With the introduction of firmware V3.2, in addition to bit 8, which already existed, 
bit 4 has been introduced - in conformance with PROFIsafe. This is used to control 
the SLS safety functions The parameterization defines as to whether the original bit 
is used or the new bit (refer to Chapter 4.6.2.2). 

** the SLS status bit is signaled back to the S7 safety program using bit 8 and the 
new bit 4 that is in conformance with PROFIsafe. 
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4.6 Download 

4.6.1 S7 program 

To download the S7 program, you will require a connection between the MPI inter-
face of your PG/PC and the MPI interface of the S7 CPU. 
• Start the SIMATIC Manager. 
• De-archive the function example supplied. 
• Open the G120_Safety_App_3_V20 project. 
• Select the MPI interface parameterization using Options > Select PG/PC in-

terface… . 
• Open HW-Config and download this into the control. After the download re-

close HW-Config. 
• In the SIMATIC Manager, select CPU315F-2 PN/DP. 
• Open the Safety Program dialog box using Options > Edit safety program. 
• Press the Download button and in the dialog window that is then displayed, 

press Yes to download the standard blocks. 
• Enter the password siemens into the Password for Safety Program dialog 

window that opens. 
• After you have successfully downloaded the standard blocks you can re-close 

the Safety Program dialog box. 
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4.6.2 Setting the SINAMICS G120 IP address and device name 

Different than for Profibus, for PROFINET, the node addresses are not set in the 
hardware, but in the software. To do this, a connection is required between the 
PG/PC and the PROFINET interface of the SINAMICS G120 via TCP/IP. 
• To do this, connect the PROFINET cable from the SINAMICS G120, interface 

X01 P2 to the Ethernet interface (port) of your PG/PC (refer to Chapter 4.1).  
• Set the IP address and the subnet mask of the Ethernet card of your PG/PC as 

follows. 
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• Using Options > Set PG/PC Interface…. select the TCP/IP interface parame-
terization. You can carry out all additional steps via this interface during the 
course of the function example.  

 

 
 
• Then, using PLC > Edit Ethernet Node…, open the dialog box Edit Ethernet 

Node.  
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• Press the Browse… button  
 

 
 
• In the dialog box that then opens, select the node with the SINAMICS device 

type and then press the OK button. 
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• (1.) Now, enter under IP-adresse: 192.168.0.2 and under Subnetmask: 
255.255.255.0. (2.) Then press the Assign IP Configuration button. 

 

 
 
• (3.) After completing the IP configuration assignment, enter the device name - 

assigned in HW Config - under Device name: (in this particular function exam-
ple, G120). (4.) This is then assigned to the SINAMICS G120 by pressing the 
Assign Name button. 

• Close the mask by pressing the Close button. 
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4.6.3 SINAMICS G120 configuration 

When this has been completed, download the SINAMICS G120 configuration using 
the STARTER parameterizing tool.  
• Starting from the main path of the SIMATIC Manager, start the STARTER pa-

rameterizing software by selecting the SINAMICS_G120 icon and double click 
on the Inbetriebnahme icon. 

 

 
 

• Then, in the Project Navigator of the STARTER parameterizing software select 

the object "G120" (1.) and press the button  (2.) to establish the online con-
nection to the drive inverter. 

 

 
 

• After you have established the online connection, press the button  to 
download the SINAMICS G120 drive parameters. 

• Follow the instructions on the screen and acknowledge the prompt "After 
loading, copy RAM to ROM". 

• You must then enter the safety parameters of the SINAMICS G120. These 
may not be - and cannot for safety reasons - be transferred into the drive in-
verter by downloading from the PG / PC. 
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4.6.3.1 Safety functions 

• In the Project Navigator, select Functions and then open the dialog box for the 
safety functions by double clicking on Safety Integrated. 

 

 
 
• Before you start the safety commissioning change the PROFIsafe destination 

address (1.) to 200. This value can’t be changed with the other safety parame-
ters in the password protected area. 

• Then press the button Change settings (2.) and enter 12345 (standard pass-
word) in the password screen that then opens. 

• From the following screen forms transfer the appropriate values into your 
project. Take into consideration that in certain instances there are different 
value formats for processor 1 and 2 (e.g. s and ms, Hz and kHz). The reason 
for this, is that for the two processors in the SINAMICS G120, which should 
operate in parallel and should come to the same result, separate parameter 
sets are available for safety reasons.  
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4.6.3.2 "Enables" tab 

 
 
In this screen parameterize which source (PROFIsafe or the Safe digital inputs) 
is used to activate the safety functions of SINAMICS G120. 
• Upper section:  

– 1.) Path to activate the safety functions via PROFIsafe (this path is used in 
this function example).  

– 2.) Path to select the PROFIsafe protocol version. Deactivated switches 
select the previous version with SLS control using bit 8. Activated switches 
select the new control that uses bit 4 in the PROFIsafe telegram – and 
which is in conformance with PROFIsafe. 

• Center section: Path to activate the safety functions using Safe digital inputs 
0 and 1 (not used in this function example).  

• Lower section: Here, the monitoring of the Safe Brake Control module can be 
activated (not used in this function example).  

 
After you have parameterized the enable signals, then select the tab Safe Torque 
Off. 



 

SINAMICS G120; Safety via Profinet with PROFIsafe Entry-ID:29585944
 

 
A&D Safety Integrated Page 27/67 SD-FE-I-005-V20-EN
                                                                                          

C
op

yr
ig

ht
 ©

 S
ie

m
en

s 
A

G
 2

01
0 

A
ll 

rig
ht

s 
re

se
rv

ed
 

S
D

_F
E

_I
_0

05
_V

20
_E

N
.d

oc
 

  

4.6.3.3 "Safe Torque Off” (STO) tab 

 
 
The shutdown paths of a safety-relevant plant or system must be subject to a 
forced checking procedure at regular intervals. This is in order to identify "dormant" 
errors. SINAMICS G120 automatically carries out a forced checking procedure of 
the shutdown paths in the drive unit. This procedure is known as the forced check-
ing procedure. 
A reduced form of the forced checking procedure limited to self-test the brakes and 
processor is always automatically executed after "Safe Torque Off" (STO) is exited. 
This type of forced checking procedure is known as the process checking proce-
dure. 
Further, by appropriately parameterizing the system, it is possible to initiate a 
forced checking procedure each time that STO is exited. 
• Upper section: Using Test of the shutdown channels when leaving STO, 

you can select how the forced checking procedure for the shutdown channels 
is carried-out. 
– Activated: A dynamization (forced checking procedure) is carried-out 

when first powering-up after “Safe Torque Off” (STO). It takes about 2.4s to 
check the shutdown channels. This delay time should be taken into ac-
count for an on command. 

– Deactivated: The shutdown channels are only checked after initiating the 
function “Latched Safe Torque Off” (LSTO) in a fault condition/situation and 
after switching-out the power supply voltage and switching-in again. When 
exiting an STO, a delay time is not incurred as only the process checking 
procedure is carried-out. 
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• Center section: When activating the safety functions via the safe digital inputs 
of the SINAMICS G120, a debounce time and a filter for the response time 
can be set here. These settings are not relevant for the function example de-
scribed here. 

• Lower section: The SINAMICS G120 automatically monitors when a forced 
checking procedure was carried-out the last time. Set the time up to the next 
forced checking procedure in the field Test periods for shutdown paths. The 
time can be selected between 0.1 and 8760 hours (6 min up to 1 year). The 
timer is re-started after each forced checking procedure. Alarm A1699 is output 
in operation to flag you that this monitoring time has expired. A process check-
ing procedure does not replace forced checking procedure and therefore does 
not reset the timer. 

 
After you have parameterized the Safe Torque Off function, select the tab Safe 
Stop 1. 
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4.6.3.4 “Safe Stop 1” (SS1) tab 

 
 
The parameters relevant for “Safe Stop 1” (SS1) are set in this screen form.  
• (1.) Using the threshold value Standstill detection, define the speed at which 

standstill (zero speed) is detected and "Safe Torque Off" (STO) is activated. 
Please note that the value should be entered once in kHz and once in Hz. 

• (2.) The Ramp-down time Tr for SS1 ... should then be entered. Please note 
that the value is entered once in s and once in ms. The ramp-down time Tr al-
ways refers to the safety reference frequency of 200Hz in the drive itself.  
This ramp-down time is also used for the deceleration for "Safely Limited 
Speed" (SLS). 

• (3.) The monitoring tolerance is set using Delay Tv, until monitoring active. 
The drive inverter continually monitors - with tolerance Tv - the braking of the 
drive.  
If the tolerance is selected too low, then the monitoring function could be incor-
rectly tripped. If the tolerance is too high, then if an actual fault does develop, 
an unnecessarily long time is wasted. Please note that the value is entered 
once in s and once in ms. 

• You can download an Excel tool to calculate SS1 and SLS parameters under 
the following link: 
http://support.automation.siemens.com/WW/view/en/24488874 

 
After you have parameterized the function Safe Stop 1, select the tab Safely Lim-
ited Speed. 

http://support.automation.siemens.com/WW/view/en/24488874�
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4.6.3.5 Safely Limited Speed (SLS) tab 

 
 
The parameters relevant for “Safely Limited Speed” are entered in this screen form. 
• (1.) The SLS mode is defined here. For this function example set mode 1 (Ac-

tivate the braking ramp while f > f_SLS (1)).  
• The following four modes - with the appropriate properties - are available: 
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SLS 
Mode Properties 

Initiate STO with braking ramp and drive fault when f >f_SLS (0)  
Limiting to a safely limited speed   

The speed can not be changed via frequency setpoint 

Mode 0 

 

 
 

 If, when SLS is activated, the actual frequency is greater than the Upper SLS 
limit, SS1 is activated and then LSTO (safe torque shutdown with latching). 

 If, when SLS is activated, the actual frequency lies between the Upper SLS 
limit and the Setpoint for SLS, then the Setpoint for SLS is activated. The 
frequency cannot be changed. 

 If the actual frequency lies below the Setpoint for SLS, the actual frequency is 
kept. The frequency cannot be changed. 

 STO is activated if the actual frequency is below 1Hz. 

 SLS can be ended with ON/OFF1, OFF2 and OFF3 – and as a consequence, 
the drive is stopped. The drive can only be re-started if SLS was withdrawn. In 
just the same way - SLS is ended by activating STO and SS1. 
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SLS 
Mode Properties 

Activate braking ramp while f > f_SLS (1)  
Reducing to a safely limited speed 

The speed can not be changed via frequency setpoint 

Mode 1 

 

 
 

 If, when activating SLS, the actual frequency is greater than the Upper SLS 
limit, the Setpoint for SLS is activated and the drive is braked down to this 
setpoint using the SS1 safe braking ramp (refer to Safe Stop 1 tab, parameter 
Ramp-down time Tr for SS1 ... ). 

 If the actual frequency lies below the Setpoint for SLS, the actual frequency is 
kept. The frequency cannot be changed. 

 STO is activated if the actual frequency is below 1Hz. 

 SLS can be ended with ON/OFF1, OFF2 and OFF3 – and as a consequence, 
the drive is stopped. The drive can only be re-started if SLS was withdrawn. In 
just the same way - SLS is ended by activating STO and SS1. 
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SLS 
Mode Properties 

Initiate STO without braking ramp and with drive fault while f > f_SLS  
Limiting to a safely limited speed   

The speed can be changed via frequency setpoint 

Mode 2 

 

 
 

 If, when activating SLS, the actual frequency is greater than the Upper SLS 
limit, LSTO (safe torque shutdown with latching) is activated. 

 If, when activating SLS, the actual frequency lies below the Upper SLS limit, 
the frequency is kept. The frequency can be changed between 1 Hz and the 
Upper SLS limit (Caution: For V/f, take into account the slip compensation). 

 If the actual frequency drops below 1Hz or the Upper SLS limit is reached, 
STO is activated. If the upper tolerance limit for velocity monitoring is ex-
ceeded, then STO is latched – i.e. LSTO. 

 SLS can be ended with ON/OFF1, OFF2 and OFF3 – and as a consequence, 
the drive is stopped. The drive can only be re-started if SLS was withdrawn. In 
just the same way - SLS is ended by activating STO and SS1. 
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SLS 
Mode Properties 

SLS with ramp down from 0Hz (3)  
Start with active SLS, limit to a safely-limited speed.  
It is possible to vary the speed via the setpoint input.  

The speed can be reduced to 0Hz and reversing operation is possible.  

Mode 3 

 

 

 If SLS is activated at standstill, then the frequency inverter must be started 
within 5s and a frequency of 1Hz must be exceeded. Otherwise, the frequency 
inverter switches into the safe state with STO. If the frequency setpoint that 
has been entered lies above the Upper SLS limit, LSTO (Safe Torque Off with 
latching) is activated.  

 In JOG-Mode with activated SLS please ensure that the drive frequency 
reaches 1Hz within 5s. Otherwise upon the 3rd activation of SLS the drive will 
switched off with LSTO and error F1614 (additional info 105 / 205). 

 If, when activating SLS, the actual frequency is higher than the Upper SLS 
limit, LSTO (Safe Torque Off with latching) is activated. 

 If, when activating SLS, the actual frequency is below the Upper SLS limit, 
then the frequency is kept. The frequency can be varied between 0Hz and the 
Upper SLS limit (caution, for V/f control take into account the slip compensa-
tion). However, the frequency range below 1Hz must be again exited within 5s 
- otherwise the frequency inverter will shut down (trip) with STO. 

 In reversing operation, the frequency range between +/- 1Hz must be passed 
through within 5s - otherwise the frequency inverter will shutdown (trip) with 
STO. 

 With ON/OFF1, OFF2 und OFF3 the drive can be stopped. In addition SLS 
needs to be deactivated manually. For example after deactivation of ON/OFF1 
with active SLS the drive can only be started after a deactivation of SLS and if 
necessary reactivation of SLS. 

 SLS is also ended by activating STO and SS1. 
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You can obtain more detailed information about the SLS modes from the Function 
Manual SINAMICS G120, SINAMICS G120D, SIMATIC ET200S FC, SIMATIC 
ET200pro FC  in Chapter Fail-Safe Functions under Safely Limited Speed.  
Download from: 
http://support.automation.siemens.com/WW/view/en/25021636/133300 
 
 

 
 
• (2.) These input fields are displayed only for SLS mode 0 and 1. Setpoint for 

SLS is used to set the frequency to which the frequency setpoint is internally 
limited in the drive unit after the function Safely Limited Speed SLS has been 
selected. Please note that the value is entered once in Hz and once in kHz.  

• (3.) The monitoring limit is set using the Upper SLS limit. If Safely Limited 
Speed SLS is active and the actual frequency exceeds this value, then 
SINAMICS G120 outputs a fault message and goes into the safe condition 
(Safe Torque Off, STO). Please note that the value should be entered once in 
Hz and once in kHz. 

• You can download an Excel tool to calculate SS1 and SLS parameters under 
the following link: 
http://support.automation.siemens.com/WW/view/en/24488874 

http://support.automation.siemens.com/WW/view/en/25021636/133300�
http://support.automation.siemens.com/WW/view/en/24488874�
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4.6.3.6 Accepting settings 

• After you have made all of the settings press the Accept settings button. 
• You can now change the standard password. If you are still not certain that 

your safety parameterization has been completed, then you should press the 
Later button.  
However, after you have completed the commissioning phase, do not forget to 
change the standard password for a password that only you know or a person 
that you trust. Only then can you be sure that only authorized persons can 
change/modify safety parameters. 

• To complete the parameterization of the safety functions you must now ac-
knowledge the checksums of the two processors. To do this, transfer the first 
checksum, processor 1 into the set checksum, processor 1. Do exactly the 
same for the checksum of processor 2.  
Please note that the two actual checksums and therefore the two set check-
sums must be the same. If this is not the case, then you must re-check your 
parameterization of the safety functions and resolve the different values. 

 

 

4.6.3.7 Exiting the STARTER parameterizing software 

• If you don't wish to set any additional parameters, then you can now exit the 
STARTER commissioning tool. 

• In the tree select SINAMICS G120 and transfer all of the parameter changes 

into the ROM memory of the SINAMICS G120 by pressing the  button 
• Then transfer all of the parameters into your offline a project by pressing the  

 button. 

• Disconnect the PG / PC from SINAMICS G120 by pressing the  button. 

• Now you can close STARTER using Project > Close or by pressing the  
button. 
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4.6.4 Function test 

The function test can be carried-out, if 
• The hardware components are connected-up 
• The hardware settings have been made 
• The S7 project is in the CPU  
• The configured software has been downloaded into the SINAMICS G120 and 

the safety functions have been parameterized 
• The CPU is in the RUN state 
 

No. Action Response 

1 If it is pressed, release the Emergency 
Stop pushbutton. 

 

The signal lamp for "Safety functions activated 
or fault" (Q 0.7) goes dark. 

2 Press the pushbutton "Acknowledge 
safety functions and faults" (I 24.3).  
Please wait during BUSY (DB1. DBX17.0 
= 0) is displayed on the BOP.  

At SINAMICS G120 LEDs RDY, STO, SS1 and 
SLS are bright  the drive and all of the safety 
functions are in the ready state. 

3 Press the switch "SINAMICS G120 Start" 
(I 0.0) 

The motor starts to run. 

Safety function STO (Safe Torque Off) 

The motor coasts down and is not braked. 
The signal lamp for "Safety functions activated 
or fault" (Q 0.7) starts to flash. 

1 Press the “Emergency Stop pushbutton 
STO” (I 24.0). 

At the SINAMICS G120 the LED ES is bright and 
LED STO flashes  STO is active, the motor is 
brought into a no-torque condition. 

2 De-activate the control of the SINAMICS 
G120 using the switch "SINAMICS G120 
Start" (I 0.0). 

 

The signal lamp for "Safety functions activated 
and fault" (Q 0.7) goes dark. 

3 Release the “Emergency Stop pushbut-
ton STO” (I 24.0) and press the pushbut-
ton "Acknowledge safety functions and 
faults" (I 24.3). 
Please wait during BUSY (DB1. DBX17.0 
= 0) is displayed on the BOP. 

At the SINAMICS G120, the LEDs RDY, STO, 
SS1 and SLS are bright  the drive and all 
safety functions are in the ready state. 

4 Press the switch "SINAMICS G120 Start" 
(I 0.0) 

The motor starts to operate again. 
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No. Action Response 

Safety function SS1 (Safe Stop 1) 

The motor follows the parameterized braking 
ramp down to the minimum frequency and stops. 
The signal lamp for "Safety functions activated 
and fault" (Q 0.7) starts to flash. 

1 Press the “Emergency Stop pushbutton 
SS1” (I 24.1) 

At the SINAMICS G120 the LED ES is bright and 
LED SS1 flashes  SS1 is active, the motor has 
been brought into a no-torque condition. 

2 De-activate the control of the SINAMICS 
G120 using the switch "SINAMICS G120 
Start" (I 0.0). 

 

The signal lamp for "Safety functions activated 
or fault" (Q 0.7) goes dark. 

3 Release the “Emergency Stop pushbut-
ton SS1” (I 24.1) and press the pushbut-
ton "Acknowledge safety functions and 
faults" (I 24.3). 
Please wait during BUSY (DB1. DBX17.0 
= 0) is displayed on the BOP. 

At the SINAMICS G120 the LEDs RDY, STO, 
SS1 and SLS are bright  the drive and all of the 
safety functions are in the ready state. 

4 Press the switch "SINAMICS G120 Start" 
(I 0.0). 

The motor starts to operate again. 

Safety function SLS (Safely Limited Speed) Mode 1 

The motor follows the parameterized braking 
ramp down to the safely limited speed. 
The signal lamp for "Safety  
functions activated and fault" (Q 0.7) is not 
bright (is dark). 

1 Press the “Pushbutton SLS” (I 24.2) and 
keep it pressed. 

At the SINAMICS G120 the LED ES is bright and 
LED SLS flashes  SLS is active, the motor is 
monitored to ensure that it does not exceed the 
safely limited speed. 
The motor accelerates back to the normal speed. 2 Release “Pushbutton SLS” (I 24.2) again 
At the SINAMICS G120 LEDs RDY, STO, SS1 
and SLS are bright  the drive and all safety 
functions are in the ready state. 
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4.6.5 Acceptance test and acceptance report 

An acceptance test must be carried-out when the machine is commissioned for the 
first time and also if a completely saved set of the safety-relevant parameters is 
changed. This procedure is used to verify the safety-relevant parameters. This ac-
ceptance test must be appropriately documented. The acceptance reports must be 
appropriately stored and archived. 
The checksum ensures that all subsequently made changes are identified. 
 
Information about the acceptance test are provided in the Operating Instruction 
Control Unit CU240S in Chapter Appendix under Acceptance Log. 
Download from: 
http://support.automation.siemens.com/WW/view/en/22339653/133300 
 
Download Acceptance test report from: 
http://support.automation.siemens.com/WW/view/en/35014199 

http://support.automation.siemens.com/WW/view/en/22339653/133300�
http://support.automation.siemens.com/WW/view/en/35014199�
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5 Key performance data of the SIMATIC CPU 
Load memory and working memory 

 Total 

Load memory Approx. 62 k 

Working memory Approx. 41 k 

Cycle time 

Total cycle time (typical) Approx. 1 ms Standard and safety program 
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6 Example code 
The individual functions of the example code are explained in the following Chap-
ters so that you will then be in a position to implement your own project. 
For this function example, the settings described no longer have to be made. 
 

Note In this example code, passwords are used for the safety functions. These are as 
follows: 

S7 safety program and HW Config: siemens 
STARTER Safety Screens: 12345 

  

6.1 Settings in the hardware configuration 
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6.1.1 Properties of the CPU 

Before the safety functions of the CPU can be used, they must be released. The 
Properties window of the CPU is opened by double clicking on the CPU315F-2 
PN/DP. 
 

 
 
Under the Protection tab, the safety functions of the CPU are enabled by selecting 
the following functions: 

 Protection level; 1: Access protect for F CPU, 
 Activate Can be bypassed with password, 
 Enter a password (in this example code, siemens), 
 Activate CPU contains safety program.  
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6.1.2 Properties of the F-DI module 

The signal sources for the safety functions (pushbuttons to acknowledge STO, 
SS1, SLS and Emergency Stop) are read-in using the fail-safe module 
DI24xDC24V (6ES7326-1BK01-0AB0). The Properties dialog box opens after dou-
ble clicking on the module. The properties of the module can be parameterized by 
selecting the Parameters tab. 
 

 
 
• (1.) Also for this module, safety-relevant operation must be enabled by select-

ing Safety mode as the operating mode. 
• (2.) The binary code that is specified under DIL switch setting (9......0) must 

be set at the rear of the module. 
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DIL switch on the module: 

 
 
• (3.) The short-circuit and cross-circuit fault monitoring of the channel group can 

be activated by selecting the function Sensor supply via module. This func-
tion should be activated as a result of how the function example is connected-
up. 

• (4.) The properties of the individual channels of the module (channels 0,12 up 
to 3,15) are parameterized as shown under Channel 0, 12.  

 
For more detailed information please refer to the Manual SIMATIC Automation 
System S7-300 Fail-Safe Signal Modules. 
Download from: 
http://support.automation.siemens.com/WW/view/en/12265765/133300 
• In order that the buttons for STO, SS1, SLS and ACK can be used in the 

safety program, symbolic addresses must be assigned for the inputs of the 
safety input module. The input window for the symbolic addresses is opened 
by selecting the module, pressing the righthand mouse key and selecting Edit 
Symbols... . 

 

 
 

http://support.automation.siemens.com/WW/view/en/12265765/133300�
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6.1.3 Properties of the SINAMICS G120 

The window of the SINAMICS G120 PROFINET properties (2.) is displayed by 
clicking once on the SINAMICS G120 icon (1.). 
 

 
 
The PROFINBUS telegram (2.) between the CPU and the SINAMICS G120 com-
prises two components. One is the Standard Telegram, in this particular example, 
Standard Telegram 352 for the communications of the SINAMICS G120 (control 
signals, status signals, frequency setpoint, frequency actual value etc.) and the 
other is the PROFIsafe for PROFIsafe communications. 
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The telegram is selected in the Catalog after pressing the  button. 
 

 
 

You can download the GSD files for the SINAMICS G120 under the following link: 
http://support.automation.siemens.com/WW/view/en/23450835 
GSD files are required to operate a node (e.g. the SINAMICS G120) on PROFINET 
– and to register (log-on) the device to the engineering tool. 
 
The PROFIsafe SIEMENS T352 telegram is used in this example. 

http://support.automation.siemens.com/WW/view/en/23450835�
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6.1.3.1 PROFIsafe telegram 

The PROFIsafe communication of the SINAMICS G120 safety functions are real-
ized using the PROFIsafe telegram. 
The Properties window of the module opens after double-clicking on the PROFIs-
afe telegram.  
 

 
 
• The PROFIsafe properties window is displayed after pressing the PROFIs-

afe… button (1). 
• The PROFIsafe properties are displayed after entering the safety password 

siemens. 
 
 



 

SINAMICS G120; Safety via Profinet with PROFIsafe Entry-ID:29585944
 

 
A&D Safety Integrated Page 48/67 SD-FE-I-005-V20-EN
                                                                                          

C
op

yr
ig

ht
 ©

 S
ie

m
en

s 
A

G
 2

01
0 

A
ll 

rig
ht

s 
re

se
rv

ed
 

S
D

_F
E

_I
_0

05
_V

20
_E

N
.d

oc
 

   
 

• The value of F_Dest_Add specified by HW Config (PROFIsafe address of the 
SINAMICS G120) must be entered into SINAMICS G120 parameter p9810 
(refer to Capture 4.6.3.1). 
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• For F_WD_Time (PROFIsafe Watchdog Time) minimum twice the value of the 
call environment cycle of the S7 safety program must be entered. In this par-
ticular function example the S7 safety program is called every 100 ms in OB35 
(refer to HW-config, Properties CPU, Cyclic Interrupts).  
 

 
 

• This means that a value of 200 must be entered for F_WD_Time. 
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In order that SINAMICS G120 can use the safety functions in the safety program, 
symbolic addresses must be assigned for the inputs and outputs of the PROFIsafe 
module.  
The input window for the symbolic addresses is opened by selecting the PROFIs-
afe module in the HW-Config, pressing the righthand mouse key and selecting Edit 
symbols... . 
 

 
 
Only the inputs and outputs listed in this example are relevant for communications. 
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6.1.3.2 Standard Telegram  

 
 

Various pre-assigned telegrams are available for this communication; these can be 
selected from the hardware catalog (refer to Capture 6.1.3). 
The Standard Telegram 352 is used in this function example. It contains a length 
of 6 words sending (output) and receiving (input) – beginning from starting address 
256. 
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6.2 Functions of the Step 7 program (without safety pro-
gram) 

6.2.1 Program overview 

 
 
 
The Step 7 program essentially comprises blocks FB10, FC100 and DB1 that are 
called in the cyclic program (OB1). 
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6.2.2 DB1, Axis_DB 

The Axis_DB represents the interface between the S7 program and the SINAMICS 
G120 via FC100. 
Axis_DB is generated from UDT 1 (Axis_DB_G120) 
 

Principal structure of Axis_DB: 

Address Symbolic name Type Function 

Internal data 

DBW0 Basic_Data.Moduleadress INT I/O start address of the SINAMICS G120 (refer to 
HW Config) 

DBB3 Basic_Data.Drivetyp Byte Drive type, must be 2  

S7 -> SINAMICS G120 

DBW4 Control_signals.STW2 Bool Control word 2 (for details, refer to the S7 program) 
DBW6 Control_signals.STW1 Bool Control word 1 (for details, refer to the S7 program) 
DBW8 Control_signals.Frequency_set INT Frequency setpoint in x.x %  
DBW10 Control_signals.Torque_set INT Torque setpoint in x.x %  

SINAMICS G120 -> S7 

DBW14 Status_signals.ZSW2 Bool Status word 2 (for details, refer to the S7 program) 
DBW16 Status_signals.ZSW1 Bool Status word 1 (for details, refer to the S7 program) 
DBW18 Status_signals.Actual_frequency INT Frequency actual value in x.x %  
DBW20 Status_signals.Actual_current INT Current actual value (Value from SINAMICS G120) 
DBW22 Status_signals.Actual_current_A INT Current actual value in x.xx A 

Error messages 

DBW24 Faults.Drive_error_number INT Actual error number of the SINAMICS G120 
DBW26 Faults.Drive_alarm_number INT Actual alarm number of the SINAMICS G120 

 
In this function example the individual data of the DB1 are supplied in FB10. 
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6.2.3 FB10, Organization  

This block is called-up in absolute terms in OB1 and in turn calls up FC100. 
Principle of the FB10 

Network Function 

1 Calls the FB11 to generate the frequency setpoint 

Controls the SINAMICS G120 via the axis-DB, DB1. 
Calls the SINAMICS G120 control block FC100.  
Provides the feedback signals – incl. error and alarm number 

2 

This network can be used as template for additional SINAMICS G120 control functions. 
3 Controls the signal lamp for "Safety function activated or fault active". 

 

6.2.4 FC100, Control of SINAMICS G120 

SINAMICS G120 is controlled using the FC100 via PROFINET.  
Only signals from the Axis_DB are used to control the block - but no fixed ad-
dresses - this is the reason that instances can be used.  
This block can be used in the same way for both a standard and a Safety 
SINAMICS G120. 
 

Formal operands of the FC100 

Formal operands Type Description 

Nr_Axis_DB IN Number of the Axis-DB generated using UDT1  

Internal_Error OUT 
Displays an internal error     
0 = no error 
1 = incorrect Axis-DB type (wrong UDT) 

 
Principle structure of the FC100 

Network Function 

Opens the Axis_DB specified using the formal operands Nr_Axis_DB. 
1 

Generates the internal error message. 

2 Reads-in the SINAMICS G120 status words, processes these and saves them in the 
Axis_DB. 

3 Resets internal error messages. 

4 Converts frequency and torque setpoint from the Axis_DB (entered in x.x %) into the 
SINAMICS G120 format (hex). 

5 Enters SINAMICS G120 error and alarm number into the Axis_DB. 
6 Sends control words from the Axis_DB to the SINAMICS G120 
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6.3 Functions of the Step 7 safety program  

The basic programming of Distributed Safety - the S7 programming  
tool for F control systems - is not discussed in this function example.  
This function example only explains and discusses the FB201 user block for safety 
functions. 

6.3.1 Program overview 

CALL F-Call

OB35
Cyclic Interrupt

100ms

Read digital inputs of the 
F-Periphery and transfer 
it to the process image of 

the inputs                         
----------------------------------

Handle user safety 
program FB201

----------------------------------
Handle standard safety 

blocks                              
----------------------------------

Transfer of the output 
process image to the F-

Periphery outputs 

FC200
F-Call

Reading of the safety 
push buttons and 

generate the safety 
functions

----------------------------------
Quit safety function

----------------------------------
Control SINAMICS G120 

safety functions
----------------------------------
Read SINAMICS G120 

safety status 
----------------------------------
Generate status signals 

for the standard S7-
Program

FB201
Safety program
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6.3.2 FB201, Safety program 

The individual safety sensors are read into the FB201, interlocked with one another 
(logically combined) and the SINAMICS G120 safety functions controlled. 
It is necessary to enter the safety password to process/handle the FB201. This 
password is siemens. 
 

Principle structure of the FB201 

Network S7-Program Function 

Safe Torque Off (STO) 
Reads-in the Emergency Stop pushbutton 
Safety_PB_STO (I 24.0), logically inter-
locked using the F-Standard block FB215 
(F_ESTOP1) and forms auxiliary flag 
No_STO 
 

1 

 
Acknowledges the safety function  

Safe Stop 1 (SS1) 
Reads-in the Emergency Stop pushbutton 
Safety_PB_SS1 (I 24.1), logically inter-
locked using the F-Standard block FB215 
(F_ESTOP1) and forms auxiliary flag 
No_SS1 
 

2 

 
Acknowledges the safety function  

3 

 

Controls the SINAMICS G120 safety func-
tion STO (Q 14.0). 

4 

 

Controls the SINAMICS G120 safety func-
tion SS1 (Q 14.1). 

5 

 

 

Controls the SINAMICS G120 safety func-
tion SLS (Q 15.0).  
With the introduction of firmware V3.2 - in 
addition to the previous bit 8 (Q15.0), bit 4 
(Q14.4) has been inserted to control the 
SLS safety function. Bit 4 is in conformance 
with PROFIsafe. The parameter assignment 
is used to define as to whether the original 
or the new bit is used (refer to Chapter 
4.6.2.2).  
You can delete the bit that is not used in 
your program. 
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Network S7-Program Function 

6 

 

Acknowledges passivation and safety com-
munication errors between the S7-CPU and 
the SINAMICS G120. 

7 

 

Acknowledges passivation and safety com-
munication errors between the S7-CPU and 
the safety digital input module SM326. 

8 

 

No STO and no SS1   standard program. 

9 

 

Signal "Emergency Stop acknowledge"  
standard program. 

10 

 

 

Feedback signal STO / Power removed 
from SINAMICS G120  standard program.
Instead of being transfered to the standard 
program it goes without saying that this 
signal can be used in the safety program.  
 

11 

 

 

Feedback signal SS1 from SINAMICS G120 
 standard program. 

Instead of being transfered to the standard 
program it goes without saying that this 
signal can be used in the safety program.  
 
 

12 and 13  

 

Feedback signal SLS  (original PROFIsafe 
telegram = network 12, signal in 
conformance with PROFIsafe = network 13) 
from SINAMICS G120  Standard 
program. 
In your program you can delete the network 
that is not being used. 
Instead of being transfered to the standard 
program it goes without saying that this 
signal can be used in the safety program.  
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6.4 SINAMICS G120 - parameterization the safety functions 

Refer to Chapter 4.6.2, SINAMICS G120 parameterization 
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6.5 SINAMICS G120 parameterization 

In order that the basic SINAMICS G120 functions can be parameterized, the safety 
functions in the S7-CPU and in the drive inverter itself must already have been 
commissioned. 
The reason for this is that during parameterization a motor identification routine is 
carried-out (the motor and cables are measured) - and if vector control is activated 
- the controller is optimized. Both of these functions require that the safety func-
tions are in the ready state.  

6.5.1 SIMATIC Manager - inserting SINAMICS G120  

• In SIMATIC Manager select the tree G120_Safety_App_1 and using Insert > 
Program > SINAMICS select a SINAMICS G120 type object. 
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• Make the following settings and press the OK button.  
 

 
 



 

SINAMICS G120; Safety via Profinet with PROFIsafe Entry-ID:29585944
 

 
A&D Safety Integrated Page 61/67 SD-FE-I-005-V20-EN
                                                                                          

C
op

yr
ig

ht
 ©

 S
ie

m
en

s 
A

G
 2

01
0 

A
ll 

rig
ht

s 
re

se
rv

ed
 

S
D

_F
E

_I
_0

05
_V

20
_E

N
.d

oc
 

  

6.5.2 Calling the STARTER parameterization tool  

• Starting from the main path of the SIMATIC Manager, start the STARTER 
parameterization software by selecting SINAMICS_G120 and double click on 
Inbetriebnahme. 

 

 
 
• Then, in the Project Navigator of the STARTER  

parameterization software select the object G120 (1.) and press button  (2.) 
to establish an online connection to the drive inverter. 

 

 
 

6.5.3 STARTER - carrying out quick commissioning 

• The screen form with the actual configuration is opened by double clicking on 
Configuration in the Project Navigator. 

• The quick commissioning Wizard is started after pressing the 
 button. 

• Enter the appropriate values into the Control structure to Encoder screen 
forms. You can call-up corresponding help texts in the individual screen forms 
by pressing on the Help button.  

• In the screen form Drive functions, select for Motor identification, the func-
tion Ident. of al param. in standstill incl. the saturation curve (3). 

• Enter the corresponding parameters into the Important parameters screen 
form. 
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• In the screen form Calculation of the motor data, select Restore factory set-
ting and calculate motor data. 

• In the screen form Summary do not activate the function RAM -> ROM, but in-
stead press the Finish button. 

6.5.4 STARTER - carrying out a motor identification routine 

• After completing the quick commissioning, alarm A0541 (Motor data-
identification active) is displayed. Please carefully note that when starting the 
motor identification routine current flows in the motor. For hanging (suspended) 
axes the load must always be supported.  

• To start the motor data identification routine, in the Project Navigator select the 
menu item Commissioning and activate by double clicking on Control panel. 

 
 
• Press Assume control priority and carefully note the security/safety informa-

tion and instructions. Then activate Enables. 
 

 
 
• 1.) If the Control panel isn't completely displayed on your PG/PC, then press 

the  button. 

• The motor data identification routine is started by pressing the  button. Do 
not exit the STARTER software and go to another task as otherwise the motor 
data identification routine will be interrupted for safety reasons.  

• Please wait until the  button changes back to the  button. 
• Return the control priority to the S7 control by pressing the 

 button. 
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6.5.5 STARTER - setting the Profinet communications 

• Communications between the CPU and the SINAMICS G120 must then be pa-
rameterized. To do this, open the screen for the communication settings using 
Communication -> Profinet. Select the tab Transmit direction. 

• To start, select the Standard-Telegram 350 (350) from Message frame: (1.). 
This pre-assigns the telegram. 
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• Then replace telegram 350 by telegram type Free BICO connection (999) (1.). 
Deactivate any possibly active Suppress inactive interconnections function 
(2.) and establish the following interconnections (3.): 

• PZD 5 = r2131 (Last fault number code) 
• PZD 6 = r2132 (First warning number code) 
 

 
 
• Finally, you only have to save the SINAMICS G120 configured software in the 

ROM memory of the drive inverter. To do this in the Project Navigator select 
the menu item G120 

 

 
 

• In the function bar press the  button. 
• Please wait until the download operation has been completed. 
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7 Evaluation according to IEC 62061 and ISO 
13849-1 
With this function example two Safety Evaluation Tool projects for each standard 
are provided. 
IEC 62061:    SD_FE_I_005_V20_EN_IEC.set 
ISO 13849-1: SD_FE_I_005_V20_EN_ISO.set 
 
Link to the Safety Evaluation Tool: 
www.siemens.com/safety-evaluation-tool 

http://www.siemens.com/safety-evaluation-tool�
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8 Appendix 
8.1 Reference data 

This list is in no way complete and only reflects a selection of suitable references. 
 

Subject area Title 

Application sample Safety INTEGRATED  
Order-No.: 6ZB5310-0MK01-0BA2 

 

8.2 Internet link data 

Subject area Title 

Link to safety items http://support.automation.siemens.com/WW/view/
en/20810941 

SINAMICS G120 
Documentation 

http://support.automation.siemens.com/WW/view/
en/22339653/133300 

Siemens customer 
support homepage 

Customer Support 

Safety integrated 
homepage 

Safety Integrated 

SINAMICS G120 
Homepage 

http://www.automation.siemens.com/sd/sinamicsg
120/index_00.htm 

Safety Evaluation Tool www.siemens.com/safety-evaluation-tool 
 

 

8.3 History 

 

Version Datum Change 

V1.0 October 2006 First edition 
V2.0 June 2010 General reworking of the document 

Changeover to firmware V3.2 
Expanded functionality for evaluation according to IEC 
62061  

 

http://support.automation.siemens.com/WW/view/en/20810941�
http://support.automation.siemens.com/WW/view/en/20810941�
http://support.automation.siemens.com/WW/view/en/22339653/133300�
http://support.automation.siemens.com/WW/view/en/22339653/133300�
http://www.ad.siemens.de/support�
http://www.automation.siemens.com/cd/safety/index_76.htm�
http://www.automation.siemens.com/sd/sinamicsg120/index_00.htm�
http://www.automation.siemens.com/sd/sinamicsg120/index_00.htm�
http://www.siemens.com/safety-evaluation-tool�
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8.4 Evaluation / feedback 

 
I DT MC PMA APC 

D-91506 Erlangen 

 

Fax.: 09131 98 – 1297 

Mail: Online-support.automation@siemens.com 

 

Sender 

Name:  

Department: 

Location:   

Telephone:  

Internet address: 

If you came across errors when 
reading this document please let 
us know using this form. We'd 
also be thankful for any sugges-
tions and recommendations for 
improvement. 

 

Evaluation of the function example 
Extremely good  Good   

Not so good  because 

....................................................................................................................................................... 

Subject of interest            Subject not interesting    

Scope sufficient            Too detailed                               Too superficial           

Understandable            Sometimes understandable       Not understandable   

Good layout            Average layout                   Poor layout                

Often used            Infrequently used                   Used only once         

Time saving by using the document when compared to before:  
No time saving        approx. 5%    approx. 10%       other...........% 

Suggestions:  
....................................................................................................................................................... 

mailto:Online-support.automation@siemens.com�
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